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Introduction
This past year marked the first time digital camera sales surpassed those of traditional film cameras. With digital
photography on the rise, we have been witness to an entirely new market that caters to the ever-increasing needs of
this maturing technology. Digital is in and the quality of cameras and their images is just blowing away their
traditional film-based counterparts. Five years ago when 2 megapixel (MP) cameras hit the market, digital image
technology had caught up with 35 mm film-based technology. Today, 4 MP cameras are in common use and 8 MP
cameras are emerging at the high end of the consumer market. Professionals of course are paying big bucks for
digital cameras with resolutions of 12 MP and beyond. Yes, across the spectrum of users, digital is definitely in.
There are few remaining good reasons not to jump on the digital bandwagon. The higher resolution, better color
rendition, and ability to adjust images on your home computer open new opportunities for the photo hobbyist. In
this tech note, we’ll explore these advantages and some of the new opportunities you have for sharing your
photographs with others.
Monitor calibration. As recommended in more detail in my tech note “Digital Photography II”, use a good
calibration program to calibrate your computer monitor. Print out test images and adjust your brightness until you
achieve good agreement.

Monitor calibration using Pantone’s ColorVision SpyderPro
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Comparing Digital to Film-Based Images
A comparison between the two technologies requires us to understand how the images are formed at the microscopic
level. Basically, the elemental pieces of a picture are made up of pixels in a digital image and grains in a film
image. A direct method of comparison is to take a photograph of a scene using a digital camera and then shoot the
same scene with a film camera. After developing, scan the film at a high setting such as 2400 dpi and examine both
images on your computer at high magnification, such as 800x. You will see that the grain structure limits the
resolution of the film image just as pixel density limits the resolution of the digital image. You will also see the
digital camera’s pixel rendition is more consistent than the digitized film’s grain structure. Colors are more
consistent and transitions are smoother.
Even though the digital camera’s charge-coupled device (CCD) sensor is smaller than a 35-mm frame (36x24 mm)
the image quality will have significantly higher resolution. As explained in my earlier tech note “Digital
Photography”, typical 35-mm film supports a grain structure that is comparable with a 2 MP image. Folks using
type 120 film enjoy a larger frame size (60x60 mm) and, thus, a higher resolution that is comparable to an 8 MP
image. Although the film details of these large-format cameras are excellent, 8 MP digital cameras are competitive
in this market as well.
Well-established sources place the resolution of fine-grained 35-mm film at 25 MP, but the reality is that this kind of
resolution can only be achieved using the finest optics, tripod mounting, and optimum exposure of professionalgrade film. The level of pixelization required to sample a 36x24 mm film image that has 25 MP of information is
4320 dpi, resulting in a bitmapped file size of 75 MB. Most hobbyists will find their image information is
significantly less than 25 MP. For example, many of my archived Kodak Gold 200 negatives and Kodak
Ektachrome 200 slides can be scanned at 2400 dpi but their average grain size is closer to 1600 dpi. The key word
here is average (technically its the rms or root-mean-square) grain size. Smaller grains capture higher resolution (it
is these grains that yield the details) but the larger grains capture less detail, so its the average grain size that sets
your overall detail. So, if I scan a Kodak Gold 200 image at 2400 dpi, there will be some increased level of detail
when magnified but the average detail level has already been set by the average value of the film’s granularity.
When scanning a film image, every imperfection (e.g. chemical blob, dust spec, scratch, etc.) is also digitized. So,
editing these imperfections using the clone tool is simplified by scanning at a modest resolution that suits your
purposes. In other words, higher resolution requires more work. I choose to scan at 1200 dpi which keeps file size
down, makes image editing quicker, and is more than adequate for display on a mainstream computer monitor. If
your purpose is to make standard-sized prints, then scanning the film image at 1200 dpi results in a 300 dpi print
size of approx. 5.67x3.78 inches. Notice how close this is to the standard print size of 6x4 inches. In my
experience, scanning at higher resolution produces marginal improvement in standard print quality. For display on
computer screens, scanning the film image at 1200 dpi produces a pixel image of 1700x1134. That is, the image
will fill a computer monitor that has a resolution of 1700x1134, which is large compared to typical monitors on the
order of 1280x1024.
If your purpose is to make enlargements, then you’ll want to scan at a higher resolution, say 2400 dpi, so the finegrained details will be brought out. For this example, scanning the film image at 2400 dpi results in a 300 dpi print
size of approx. 11.3x7.6 inches. Notice how close this is to the standard print size of 10x8 inches. When using
professional film and camera equipment, scanning at a higher resolution (e.g. 3600 dpi) will support fine-detailed
enlargements beyond 10x8 inches.
Comparing film cameras with digital cameras. My four-year-old Kodak DC260 captures digital images at
1536x1024 (1.57 MP) and I have found the quality of its images to be very comparable with photos taken with my
Canon EF 35 mm film camera. Therefore, I still use this trusty old Kodak for work in the field. Newer digital
cameras with 4-5 MP of resolution, take images that are consistently better than most 35 mm film cameras and now
offer video capture modes as well. One final note: digital cameras vary in quality across the board. I’ve compared
4 MP images from different manufacturers/models and found significant variation in image quality.
Digital Noise
Consumers familiar with digital camera specifications have no doubt read about digital noise. One of its main
causes is a low density of photons striking the CCD sensor resulting in a grainy image. In addition to in-camera
noise reduction techniques, there are also photo editing programs that reduce digital noise. However, the major

drawback is that a grainy, underexposed image can never be fully restored. Film images taken under low-light
conditions also suffer from an increase in grain. So we need to face the fact that when an image is taken under less
than optimal lighting conditions there will be a sacrifice in quality for both film- and digital-based pictures. When
digital noise is present, one simple technique is to use your image editing program to increase the contrast and adjust
the brightness to get the sharpest image.
Another related issue with digital noise is known as grain aliasing. When scanning a film image at a pixelization
resolution that approaches the film’s average grain size, digital noise in the form of speckles becomes more
noticeable. Increasing contrast and adjusting brightness helps reduce grain aliasing as well. Another way to reduce
grain aliasing is to scan at a higher resolution.
Displaying Your Digital Images
From its humble beginnings, photography has had a main purpose of providing prints for the viewers’ pleasure.
Alternatively, slides serve the market where projection of images is desired for a larger audience. One of the
advantages of digital imaging is the fact that a computer provides a significantly larger display than a 6x4 inch print.
In addition, digital photography offers new ways to share your images. We’ll explore some of these below.
1. Although photo printers allow for direct transfer of images from your camera to hard copies, many of you will
want to copy the images to your computer so you can adjust exposure, crop the images, and archive them onto your
hard disk drive. Then select the best shots for the printer. No doubt, hard copies are the easiest and most traditional
way to share photos. The best part is that your computer replaces the dark room and the results are immediate.
There are many programs on the market for enhancing your images and adding special effects.
2. Slide shows are still in, but the hardware has changed for digital photographers. Manufacturers such as Proxima
and Epson offer excellent projectors that connect directly to your computer’s VGA port. With 1024x768 now a
common resolution, these projectors are quite comparable with traditional slide projectors. Although still expensive,
prices continue to drop as technology and demand improves.
3. Digital photography enables you to take your pictures beyond the traditional mediums of hard copies and slide
shows. With e-mail now the defacto standard for informal communications, sharing images with relatives and
friends has never been easier. Also, inserting your images in electronic documents is a snap. One of the hottest
trends is creating digital photo albums and a growing number of software packages support various means to create
and send digital photo albums. There are almost endless possibilities for sharing your photos but there are some
fundamentals you’ll want to learn for efficiently packaging and displaying them. The remainder of this tech note
will be devoted to manipulating your digital images for efficient display on the computer. Following these
techniques, your images will be sharp and your file sizes will be minimized so documents and slide shows are quick
and responsive.
Note. Many photo applications work fine with your high-resolution images, but you’ll achieve better results by
matching your image resolution to the media it will be displayed on. For example, if your display media will be a
computer monitor your image requirement is about 1 MP. What this means is that images larger than 1 MP (e.g. 2
MP, 4 MP, etc.) have too much resolution! The images will still display but your computer will take longer to
process each image. That’s because your operating system (Windows, Linux, Mac OSX, etc.) is throwing out pixels
until the image fits the screen. The same visual result will be achieved by desampling your images to 1 MP with the
added benefit that your computer will display images much faster. See details at the end of this tech note.
Sending Photos via E-Mail
Whether your photos go out as an e-mail attachment or get posted to a web-based display service, you’ll want to
desample and compress your image files. Use a photo editing program to resize your image to something on the
order of 1280x1024 or 1024x768. Make sure you enable the option (if provided) to constrain proportions (width-toheight ratio), as it will allow you to change the image width or height while keeping the overall width-to-height ratio
correct. Then save your image as a JPG file and use a quality factor of 30%. The resulting image file will be about
75-150 kB and will display with excellent clarity. If you started with a 4 MP image, with an approximate 100% JPG
file size of 3 MB, this technique will allow you to fit up to 40 images in the same memory space as one full-size
image! Desampling and compressing dramatically speeds up image file transfers via modem and displaying them

on your computer. In addition, some Internet service providers limit e-mail attachments to 1 MB, and almost all of
them cap attachments at 8 MB.
Note: For Adobe programs, JPG image quality is usually offered on a scale of 0 to 12. If you take 30% of 12, your
quality factor is 4.
Image desampling and compression is an artistic effect that you’ll want to explore on your own until you find the
technique that’s right for you. Just remember that a lower quality factor produces a smaller file size but at the
expense of image quality. Even taken to the extreme (JPG quality factor of 0), image quality is often quite
acceptable for documents. Example below.

Photo of my son at Assateague State Park for a pony roundup.
1024x768 pixels, with JPG quality factor set to 0 (file size75 kB).
Inserting Photos in Text Documents
The highest resolution you’ll need for images inserted into a text document is 300 dpi. Therefore, when inserting
photos in documents choose your desired image size in inches and multiply by 300 to convert to pixels. Then use a
photo editing program to resize the image to your desired pixel size and save as a JPG file using a quality factor of
30%. For example, if your image display size will be 4x3 inches, your image should be resized to 1200x900 pixels.
Following the procedure outlined above, desampling and compressing will reduce your photo’s file size to about 100
kB. Using this technique, your embedded photos will look great, display quickly, and the document size will be
considerably reduced. If your original image has less resolution, then skip this step as nothing will be gained by
increasing resolution.
Although 300 dpi is optimum, often 150-200 dpi is sufficient. Since this is a subjective observation, experiment
with resolution until you achieve acceptable results.
Making a PowerPoint Photo Album
Since our transition to digital photography, I haven’t made more than a couple of dozen prints. (That’s quite a
confession for having a young family at home!) Instead, our best photos are collected in digital photo albums and
shared with family and friends via CD’s. There are several software packages that feature digital photo albums but
in this article I’ll present a basic technique on creating a slide show using PowerPoint, a Microsoft Office
application.
First, select the images you wish to put into your photo album and copy them to a working folder. Working with the
copies, desample and compress your images using the techniques described above. Open a new PowerPoint file,

click on Format>Slide Layout, and select the blank slide. Close out Format. Then use Insert>Picture>From File to
place your first photo on the blank slide and use your mouse to drag the corners so your image covers the slide. You
can add a text box with information such as the subject, location, date, and photo file name. When finished with
your first slide, use Insert>New Slide to add another blank slide, then insert your next photo. Continue adding
photos until you’ve finished your album. With PowerPoint, you can add many special effects, slide transition
schemes, narrated voice files, and embedded music files. However, with the free PowerPoint Viewer 2003,
embedded applications will not function. I can’t say what limit PowerPoint places on the total number of slides but I
have photo albums with more than 400 frames. With properly sized images, an album with 400 frames is only 30
MB, has crisp transitions, and displays beautifully on a 1280x1024 computer monitor.
To get the free viewer, go on line to microsoft.com and download their PowerPoint Viewer 2003. (Hint: Search on
PowerPoint Viewer.) Run the program “ppviewer.exe” to install the viewer onto your computer. If default paths are
used, the program will install under \Program Files\Microsoft Office\PowerPoint Viewer. Create a new working
folder and name it CD, then copy all files under \PowerPoint Viewer to this new folder. This is a run-time version
of PowerPoint and the program files will run from a CD on any current version of Windows. Your viewers will be
pleased to know that no software will be loaded onto their PC.
Copy your photo album to the CD working folder and name it something simple like album.ppt. Use a text editor to
create a new file and enter the following: pptview.exe album.ppt. Save this text file as autorun.inf. When the CD is
inserted, this file will be read and the command line you entered above will execute. (Very important: autorun.inf
must be a simple text file, not a doc file!) The PowerPoint Viewer will automatically start and the album will be
displayed. Use your arrow keys to flip through the slides and hit the escape key to end the show.

An example of a finished Photo Album CD.
Avery 8692 label, created with Avery Design Pro 4.0 (a free application).
To make a CD, open your CD burning program and select all the files in your CD folder. Try burning to a
rewritable disk first to make sure everything works properly. A nice label and sleeve or case will add class to your
finished CD. Your friends and relatives are going to be blown away when they receive your photo CD albums!
Note. Microsoft’s PowerPoint Viewer 2003 has no embedded application functionality. For that matter, neither
does Word Viewer 2003. If you can get your hands on a Microsoft Office 97 Professional CD, the earlier viewers
have embedded application functionality giving you many more options for creativity. To use Office 97 versions of
PowerPoint and Word Viewers, use Windows Explorer to navigate to the Office CD folder \ValuPack. Run the
viewer install programs, then copy the program files to your CD working folder. Here’s one creative option I like:

Autorun launches Word Viewer and opens a Word document, which introduces your slide show and embeds the
PowerPoint Viewer as an icon. Double click the icon to launch the PowerPoint Viewer and album. Embedded
sounds also work in the earlier viewers.
Matching Image Resolution to Your monitor
When viewing images on the computer, keep in mind that if your monitor is set to 1280x1024 your display is on the
order of 1.31 MP. For those of you using a monitor set to 1024x768, your display is on the order of 0.79 MP. The
point here is that a super high resolution 8 MP image is overkill for displaying on mainstream computer monitors.
Although adequate for producing high-quality 300-dpi prints measuring 8x10 inches, your computer’s operating
system will throw out pixels until it achieves a correct match to your monitor, a process that takes a finite time for
each image. For images that will be displayed only on a computer monitor, set your camera at a comparable
resolution around 1 MP. If you intend to archive at your camera’s highest resolution, make copies of your images
and resample them at a lower resolution. Then use the lower resolution images for displaying on a computer.
Here’s the math behind display matching:
For a 17-inch CRT monitor (assume 16 inches viewable on the diagonal), your computer screen area measures
approximately 12.8x9.6 inches. For a good monitor, your dot pitch is 0.25 mm or better. That is, each pixel is 0.25
mm away from its neighboring pixels. This yields your dot resolution, which is approximately 102 pixels per inch.
Multiply 12.8 and 9.6 by 102 to get your monitor’s hardware resolution, in this case 1300x975 pixels. The closest
Windows display setting for this monitor’s hardware resolution is 1280x1024. Multiply 1280x1024 to get your
display resolution, which in this case comes to 1.31 MP.

